Getting Started: Exploring Your Workspace

To learn more about the Milestones window choose:
Help / Help Topics / Milestones Professional Help
Select the Index tab and type in the feature. For example Toolbox.
Getting Started: Formatting Your Schedule

CHOOSE THE TAB TO:

1. Set the schedule’s DATE RANGE
2. Set the CURRENT DATE
3. Display the CURRENT DATE
4. Display the CURRENT DATE LINE
5. Display the STATUS LINE
6. Have SYMBOLS & BARS FILL TO STATUS
7. Choose FOUR - DIGIT YEARS
8. Set the SYMBOL DATE FORMAT
9. Set the schedule’s DATE HEADINGS

Choose the Full Dialog button to find more options for a feature.

Make sure to press the APPLY buttons after entering the parameters for the schedule.

Master Phasing Schedule

1. Date Range
2. Current Date
3. Display Date
4. Current Date Line
5. Status Line
6. Symbol and Bars Fill to Status Date
7. Four Digit Year
8. Symbol Date Format
9. Date Headings
Getting Started: Formatting Your Schedule continued

**CHOOSE THE **LAYOUT** TAB TO:**

1. Set the **CHART SIZE**
2. Set the **MARGINS**
3. Set the **ROWS PER PAGE**
4. Set the **ORIENTATION**
5. Set the **LEGEND** height
6. Set the three possible **DATAGRAPh** heights
7. Setup **SUMMARY BARS**
8. Setup **BASELINE**
9. Set **DURATION** options
10. Global **SYMBOL SIZE** change.

Choose the **Full Dialog** button to find more options for a feature.

Make sure to press the **APPLY** buttons after entering the parameters for the schedule.

---

**CAMPUSS MASTER PLAN - 9711**

Preliminary Cash Flow Projection

<table>
<thead>
<tr>
<th>Phase</th>
<th>Duration</th>
<th>2012</th>
<th>2013</th>
<th>2014</th>
<th>Total Costs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Totals</td>
<td>742d</td>
<td>4/2</td>
<td>5/21</td>
<td>8/13</td>
<td>$25,400</td>
</tr>
<tr>
<td>Schematic Design</td>
<td>64d</td>
<td>3/20</td>
<td>4/1</td>
<td>5/4</td>
<td>$4,450</td>
</tr>
<tr>
<td>Design Development</td>
<td>85d</td>
<td>2/12</td>
<td>7/18</td>
<td></td>
<td>$5,030</td>
</tr>
<tr>
<td>Construction Documents</td>
<td>101d</td>
<td>1/5</td>
<td>7/18</td>
<td>11/18</td>
<td>$5,200</td>
</tr>
<tr>
<td>Permitting</td>
<td>85d</td>
<td>3/11</td>
<td>10/31</td>
<td>1/24</td>
<td>$10,220</td>
</tr>
<tr>
<td>Bidding and Negotiation</td>
<td>77d</td>
<td>5/12</td>
<td></td>
<td>1/23</td>
<td>$500</td>
</tr>
<tr>
<td>Totals</td>
<td>524d</td>
<td>4/22</td>
<td></td>
<td>9/26</td>
<td>$14,855</td>
</tr>
<tr>
<td>Construction Phase 1</td>
<td>179d</td>
<td>4/22</td>
<td></td>
<td>10/17</td>
<td>$3,545</td>
</tr>
<tr>
<td>Construction Phase 2</td>
<td>150d</td>
<td>10/13</td>
<td></td>
<td>3/10</td>
<td>$1,865</td>
</tr>
<tr>
<td>Construction Phase 3</td>
<td>57d</td>
<td>3/10</td>
<td></td>
<td>8/13</td>
<td>$3,025</td>
</tr>
<tr>
<td>Construction Phase 4</td>
<td>84d</td>
<td>5/14</td>
<td></td>
<td>8/13</td>
<td>$3,200</td>
</tr>
<tr>
<td>Construction Phase 5</td>
<td>54d</td>
<td>8/13</td>
<td></td>
<td>8/13</td>
<td>$3,400</td>
</tr>
</tbody>
</table>

---

To learn more about the tab features choose: Help /Help Topics /Milestones Professional Help
Select the **Index** tab and type in the feature. For Example **Baseline**.

---

3 of 14
**Getting Started: Formatting Your Schedule continued**

**CHOOSE THE **\[INSERT\] **TAB TO:**

1. Insert a **CHART TITLE**
2. Insert a **PAGE**
3. Insert a **PAGE BREAK**
4. Insert a **TASK ROW**
5. Insert a **NEW COLUMN**
6. Insert a **PICTURE**
7. Insert a **LEGEND ENTRY**
8. Insert a **VERTICAL LINKS**
9. Insert a **RECURRING TASK**
10. Insert a **BASELINE**
11. Insert a **DATAGRAPh**
12. Insert a **VALUESET**

Some of the Features in the insert menu are advanced features you may not use in the first schedules you build. However knowing the location of these features will help you as you become a Milestones Professional power user.

---

**Project Status Report**

**Baseline vs. Current Costs**

<table>
<thead>
<tr>
<th>Phase</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Q4</th>
<th>Q1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase 2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase 3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase 4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phase 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delivery</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Baseline Costs**
- $200,000
- $400,000
- $600,000
- $800,000

**Current Costs**
- $200,000
- $400,000
- $600,000
- $800,000

**Baseline Track**
**Revised Track**
**Current Status**
**Delivery**
Getting Started: Formatting Your Schedule continued

CHOOSE THE FORMAT TAB TO:

1. Apply a COLOR THEME
2. Add VERTICAL GRIDLINES
3. Add HORIZONTAL GRIDLINES
4. Add CURTAINS
5. Add HOLIDAY SHADING
6. Change DEFAULT TEXT
7. Change BACKGROUND COLOR, BORDER, FRAME CORNERS
8. Clear SHADOWS HIGHLIGHTS
9. Change SYMBOL SIZE
10. Set INTERNATIONAL NUMBER and CURRENCY

Assign features to tasks based on their outline level using the option: GRIDLINE, SHADING, FONT SIZES BY OUTLINE LEVEL.
Getting Started: Understanding Your ToolBox

**ARROW TOOL** - Use to select, change or move objects on the schedule

**PLUS TOOL** - Use to add information to the schedule

**SMALL PLUS** - Select to add the corresponding symbol, bar, symbol combination to the schedule.

**TEXT TOOL** - Use to add text anywhere on the schedule

**DRAWING TOOLS** - Use to draw lines, circles or squares

**HORIZONTAL BAR** - Select to add between symbols on the schedule

**SYMBOL** - Select to add to schedule

**VERTICAL LINK** - Select to add between symbols on different task rows

Double click any **SYMBOL, HORIZONTAL BAR or VERTICAL LINK** in the toolbox to change its characteristics: (Shape, Type, Size, Color, Markings, Position, Text and Date display)

Right click the TOOLBOX to change its characteristics.

Hide Toolbox
Toolbox Properties...
Switch to Standard Tool
Copy Toolbox
Paste Toolbox
Sidebar Options...
Turn on Tooltips
Getting Started: Add Information To Your Schedule

**ADD A SINGLE SYMBOL**
1. In the toolbox, select the **LARGE PLUS** tool.
2. Select a symbol in the toolbox.
3. Move the cursor to the schedule area.
4. Click and drag horizontally.
5. Let go of the mouse button at the selected symbol date.

**ADD A HORIZONTAL BAR WITH A START AND END SYMBOL**
1. In the toolbox, select the **SMALL PLUS** at the beginning of a row.
2. The entire row will be highlighted in blue.
3. Move the cursor to the schedule area.
4. Click on the start date and drag horizontally.
5. Release the mouse button on the end date.

**ADD A HORIZONTAL BAR**
1. In the toolbox, select the **SMALL PLUS** at the beginning of a row with null symbols and a horizontal bar.
2. The entire row will be highlighted in blue.
3. Move the cursor to the schedule area.
4. Click on the start date and drag horizontally.
5. Release the mouse button on the end date.

**ADD A BAR AND SYMBOL TO AN ALREADY EXISTING SYMBOL IN THE SCHEDULE.**
1. In the toolbox, select the **LARGE PLUS** tool.
2. Select a symbol in the toolbox.
3. Select a connector in the toolbox.
4. Move the cursor to the schedule area and click on the already existing symbol.
5. Continue to hold the mouse button and drag horizontally.
6. Let go of the mouse button at the desired date.
### ADD A HORIZONTAL BAR BETWEEN TWO SYMBOLS ALREADY ON THE SCHEDULE

1. In the toolbox, select the Large Plus tool.
2. In the schedule area, click once on the SYMBOL from which you want the horizontal bar to begin.
3. In the toolbox, click once on the HORIZONTAL BAR to be used.
4. In the schedule area, click once on the SYMBOL that completes the horizontal link.

### ADD A VERTICAL LINK BETWEEN SYMBOLS

1. In the toolbox, select the large Plus tool.
2. In the schedule area, click once on the symbol from which you want the horizontal to begin.
3. In the toolbox, click once on the VERTICAL LINK to be used.
4. In the schedule area, click once on the symbol that completes the vertical link. (Must be on a lower or higher row)

### 1. ADD COLUMN TEXT

1. In the toolbox, select the TEXT tool.
2. Click in the column or column heading box on the schedule and start to type.

### Add COLUMN HEADING

<table>
<thead>
<tr>
<th>January</th>
<th>February</th>
<th>March</th>
<th>April</th>
<th>May</th>
<th>June</th>
<th>July</th>
<th>August</th>
<th>September</th>
<th>October</th>
<th>November</th>
<th>December</th>
</tr>
</thead>
</table>

### 2. ADD SYMBOL TEXT

1. With the arrow tool, click the symbol on the schedule. The toolbar will change to the SELECTION tab.
2. Choose the TEXT tab.
3. In the TEXT section, enter up to 3 lines of text in the TEXT LINE 1, 2, or 3.
4. Click the APPLY TEXT CHANGES button.
5. In the TEXT PLACEMENT section, select the positioning of the text.

### 3. ADD FREEFORM TEXT

1. In the toolbox, select the TEXT tool.
2. Click anywhere on the schedule and start to type.

### 4. ADD SYMBOL NOTES

1. With the arrow tool, click the symbol on the schedule. The toolbar will change to the SELECTION tab.
2. Choose the NOTES tab.
3. In the SYMBOL NOTE section, type in your notes.
4. Click the APPLY TEXT CHANGES button.
5. Select from the variety of formatting options.
6. Use the directional pad to reposition the symbol note.
Getting Started: Change Information On Your Schedule

CHANGE A SYMBOL ON THE SCHEDULE
1. In the toolbox, select the ARROW tool.
2. In the schedule area, click once on a SYMBOL that you want to change.
3. In the toolbox, click once on a different SYMBOL.

CHANGE A BAR ON THE SCHEDULE
1. In the toolbox, select the ARROW tool.
2. In the schedule area, click once on the SYMBOL that begins the HORIZONTAL BAR you want to change.
3. In the toolbox, click once on a different HORIZONTAL BAR.

CHANGE A VERTICAL LINK ON THE SCHEDULE
1. In the toolbox, select the ARROW tool.
2. In the schedule area, click once on the SYMBOL atop the VERTICAL LINK that you want to change.
3. In the toolbox, click once on a different VERTICAL LINK.
Getting Started: Change Information On Your Schedule

HIDE/SHOW ALL SYMBOL DATES AND/OR TEXT
1. On the toolbar, click the VIEW tab.
2. In the OTHER section, click OVERRIDE SYMBOL TEXT AND SYMBOL DATE DISPLAY.

SHIFT ALL DATES BY A NUMBER OF DAYS
1. On the toolbar, click the DATES tab.
2. In the DATE RANGE TOOLS section click the SHIFT ALL TASK DATES icon.
3. Enter the number of days. Then choose FORWARD or BACKWARD.

MOVE A COLUMN
1. In the toolbox, select the ARROW tool.
2. Move the cursor to the top of the column heading’s border. The cursor changes to the COLUMN MOVE cursor.
3. Click and drag to the new location, as shown by the INSERTION cursor.

CHANGE AN EXISTING COLUMN’S TYPE
1. In the toolbox, select the ARROW tool.
2. Click the column heading of the column you want to change. The toolbar will changes to the SELECTION tab.
3. Click the SWITCH TO COLUMN icon.
4. Choose the scroll arrow in the COLUMN TYPE AND FORMAT section. Pick from the available column types.

CONVERT SYMBOL TEXT TO SYMBOL NOTES
1. On the Format tab choose Symbol Notes to first set up symbol note’s default settings.
2. Choose the Tools tab in the Other Tools section choose Convert symbol Text to Note Text...
3. Select symbols to convert.
4. Select how to convert.
Getting Started: Working With Other Products

**CHOSE THE CONNECTIONS TAB TO:**

1. COPY METAFILE (PICTURE) TO THE CLIPBOARD
   Milestones is placed into another application as a picture.

2. COPY SCHEDULE TO THE CLIPBOARD
   Milestones is placed into another application as an object which can be linked and will update when the actual Milestone file is changed.

9. COPY ALL PAGES TO POWERPOINT
   Picture of multiple page Milestones schedules will be copied into an already existing or new PowerPoint document.

10. COPY POWERPOINT SLIDES FROM PROJECT
    The Project to Milestones Wizard will open. The Milestones Professional schedule is generated. It will be copied to PowerPoint.

3. CREATE REPORT FROM PROJECT
4. CREATE REPORT FROM PROJECT SERVER
   The Project to Milestones Wizard will open. Step through the wizard. A Milestones Professional schedule will be generated.

6. SAVE CUSTOM PROJECT TEMPLATE
   Choose this option to save a changed generated Milestones Professional schedule to have it included in the import wizard.

7. MANAGE CUSTOM PROJECT TEMPLATES
   Choose this option to view and manage all your Custom Project Templates.

5. REFRESH PREVIOUSLY IMPORTED PROJECT
   Choose this option to have the generated Milestones Professional schedule be updated with the latest dates from Microsoft Project.

8. EXPORT TO PROJECT
   Choose this option to create a Microsoft Project schedule from a Milestones Professional schedule.
11. IMPORT OUTLOOK TASKS OR CALENDAR
The Outlook information is imported into set Milestones templates which can be modified after the import.

12. EXPORT TASKS TO OUTLOOK
Pick the column of information from your Milestones schedule to import as the description for the dates that will be placed into your Outlook Task List.

13. INTERNET PUBLISHING WIZARD
Choose to create schedule graphics and HTML pages-ready for your web site.

If your schedule has links to other schedules or documents hotspots will be created. Also, any Milestones schedules that are linked will also be published as HTML pages.

If your schedule is outlined, you can create a set of HTML pages called a “tiered hierarchy” with multiple HTML pages for each outline level.

14. EXPORT SCHEDULE TO XML FILE
Choose from a variety of export options.

15. IMPORT SCHEDULE TO XML FILE
Choose from a variety of import options.
Getting Started: The File Tab

1. NEW
Choose New Empty Schedule to open the blank default template.
Choose Clone Current Schedule to create a new schedule from an existing schedule.

2. WIZARD
Start with Step by Step or Select Predefined Template

3. OPEN
Choose to open an existing Chart, Sample chart, or Lesson chart.
Choose to open a Template over the chart already on the schedule. Standard templates have been predefined. Personal Templates are ones you design.
Open a Microsoft Project file to have the wizard start-up.
Learn more about the Microsoft Project to Milestones Wizard under the Help / Help Topics / Milestones Project Interface Help

4. OPEN A RECENTLY USED FILE
Choose from the list of previously used files. You can choose to edit the list by selecting Edit this list.
This is the list that appears in the Milestones Professional Startup Choices dialog box.

5. SAVE AS
Choose to save as a Chart, Template, or Microsoft Project Custom Import Template (Schedule must have originated from the Microsoft Project to Milestones Wizard. Learn more about the wizard under the Help / Help Topics / Milestones Project Interface Help)
Save as PDF for easy sharing of your schedule.
Save as HTML and the Internet Publishing Wizard displays. Learn more about the wizard under Help / Help Topics / Milestones Professional Help

6. SAVE AS PDF
Save as PDF for easy sharing of your schedule.

7. IMPORT AND EXPORT OPTIONS
Choose from a variety of import and export options.
Learn more about these under Help / Help Topics / Milestones Professional Help.
**Getting Started: The File Tab**

8. **MASTER SCHEDULE**

Choose **Treat the Current Schedule as a Master Schedule** to combine multiple Milestones schedules.

Choose **Master Schedule List for Microsoft Project Refresh**. To refresh imported information from multiple Project files into one Milestones file.

9. **UPDATE MASTER SCHEDULE, LINKED SYMBOL**

Choose **Master Schedule** under this option when lower level schedules have changed and the master needs to be updated.

Symbols can be linked between Milestones charts. To have linked symbols update choose **Linked symbols** under this option. **Help /Help Topics /Milestones Professional Help**.

10. **REFRESH PREVIOUSLY IMPORTED PROJECT**

Choose this option to have the generated Milestones Professional schedule be updated with the latest dates from Microsoft Project. **Help /Help Topics /Milestones Project Interface Help**.

11. **PRINTING**

Choose **Printing Options** to change the output size, print a specified date range, or exclude columns.